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CFS (&VFT) To QuickBooks Premier 

or Enterprise Solutions Interface 

(QBI) Manual 
For QBI users and Software Design Associates support technicians 

Last edited: 9/05/2014 

 
The purpose of this interface is to create an efficient and user 
friendly means for jobs created in CFS to transfer to Estimates in 
QuickBooks where they can be converted into Sales Orders, 
Invoices, and/or Purchase Orders. 

 
This interface can be setup to just track the sales transaction, or, 
to track the sales transaction and the inventory in QuickBooks 
affected by a job coming from CFS.  
 
During the transfer, the user may choose the QB “group” mode. In 
this mode the items will still be listed individually on the screen 
display in QB but print as a group or groups using the job 
description as the default group name. (Group is a QB option and is 
limited to 20 items per group so there could be more than one group on the 
output. See QB for more detail.) 
 
The CFS to QuickBooks Interface is built upon the CFS Enterprise 
Edition tools so QB Interface customers are automatically CFS 
Enterprise customers and receive all the Enterprise features. 
 
Note: This interface will not work with QB Pro, POS, or QB Online. It will not work with QB Pro 
because Pro does not accommodate for assemblies.  
 
 
CFS to QuickBooks Interface (QBI)    
Project Manager 
Software Design Associates 
800-544-2536 toll free 
406-256-5133 fax 
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Installation & Data Setup 
 
A Software Design Associates support person will assist in the installation and setup of the 
interface. The following is a checklist of the setup requirements that need to be dealt with. 

Installing the interface program files 

1. Backup the CFS and QuickBooks data. 
a. The data in the CFS folder to backup is the MASTER.0 file and all the files 

beginning with the word SAVE. If you operate CFS over a network, make sure you 
are backing up the files in the CFS folder on the server. 

2. Make sure the CFS program files are current. 
b.  To do this go to the CFS Utility window, Online Support, Online Services, and 

click “Check for Updates Now”. 

3. Setting in CFS> Update Master File to turn interface on. 
c. Pointer 97 needs to be set to 7. It can only be set by, or with the help of, a 

Software Design Associates technician. 

4. The interface needs to be installed on the local drive of 
network workstations. 

d. The programs and data files will be installed on the local drive. 
e.  We recommend you have a folder named “Apps” in your local CFS folder. Inside 

the Apps folder will be sub-folders for each of the CFS Enterprise apps. The only 
one that is required to be run locally is the QB Interface app. So the Apps folder 
would contain at least a folder named “QB_Interface”. This particular folder 
name is required. 

f. The usual path would end up being C:\CFS\Apps\QB_Interface. 
g. The drive letter can be something different from C and the CFS folder and Apps 

folder could have different names but the QB_Interface folder must be named 
this. Also see information below regarding the enterprise.xml file. 

5. Know the path to the QuickBooks company file.  
h. You can look this up by opening QuickBooks to the appropriate company and 

pressing the F2 key. 

6. Know which QB user the interface will link to. 
i.  During the process of interfacing to QB, a QB user will need to be chosen. This 

user must have permission to access the Chart of Accounts. This same user 
connection will be used for all the interfaces on the network. It is okay that some 
users would not normally have access to the COA because the interface only uses 
this access for choosing which accounts will be associated with new items. 
Changing what accounts exist is not an option. 
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7. Security and Permissions Settings 
j. These settings on the computer influence if CFS and QuickBooks with be able to 

transfer information back and forth. There may be a problem if the settings for 
CFS, specifically the programs the job is being exported from and 
AccXmlWrapper.exe, are different from the settings for ImportEstimate.exe 
which accesses QuickBooks. Issues to consider are the UAC. It may need to be on 
or off depending on other computer settings. Remember that if the UAC setting 
is changed, the computer needs to be rebooted for the change to take effect. The 
CFS shortcut may need to be set to Run as Administrator. The CFS data path 
and/or the QB company file path may need to be set as a UNC path. 

8. Download the CFS-QB_Interface_Files.zip 
k. Save this zipped folder into the C:\CFS folder. Extract the files into this same 

folder making sure they extract into C:\CFS and not into a sub-folder. 

9. To install in Windows XP: 
 

l. Have QuickBooks open as an administrator and in the single user mode. 

m. In the C:\CFS\CFS-QB_Interface_Installation_File folder, run the Setup.exe file. 
QDBC will be installed first, if it is not present. Make sure the default interface 
installation path is changed to the correct location, usually 
C:\CFS\Apps\QB_Interface. 

n. Towards the end of the installation have it automatically start the application. 
Browse to locate the QB company file and then click Test Connection. Follow the 
on-screen instructions. When registering the interface to access QB, choose to 
allow access even when QB is not open. It is recommended to have QB open 
when exporting jobs but this way you will not be restricted if you needed to 
export when it was not open. 

o. If CFS is running over a network, when establishing the CFS data path, either a 
mapped network drive or a UNC path are options. If one way does not work, try 
the other. (A UNC path is set by browsing through My Network Places, or 
Network to locate the main CFS folder.) 

p. Do a test transfer. The easiest way is to go to Miscellaneous Estimator, enter one 
of something and attempt the export. Remember to have a customer name. 

10. For Vista, Windows 7, Windows 8, and later installation: 
q. Close QuickBooks (Applicable for secondary setups also.) Make sure the shortcut 

icon for QB is located where it will be accessible when the interface installation 
windows are open. 

r. In the C:\CFS\CFS-QB_Interface_Installation_File folder, it is critical (see 
exception in installation troubleshooting section) to Right-click on the installer 
(Setup.exe) and choose “Run as administrator”. QDBC will be installed first, if it 
is not present. Make sure the default interface installation path is changed to the 
correct location, usually C:\CFS\Apps\QB_Interface. 

s. At the end of the installation, uncheck to start the application. Finish and then 
double click the CPANEL.exe and browse to find the QB company file. Click test 
connection and yes.  
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t. Do not close the setup window asking you to open QB. It is also critical to open 
QuickBooks by right-clicking on the icon and selecting “Run as administrator”. 
After it is open make sure it is in the single user mode. 

u. When selecting a QB user, make sure you choose a user with permission to 
access the Chart of Accounts. Allow access of the application to the QuickBooks 
file whether it is open or closed. 

v. Close QuickBooks and re-open it. After the connection is established, you don’t 
need to open QuickBooks as an administrator. 

w. If CFS is running over a network, when establishing the CFS data path, either a 
mapped network drive path or a UNC path are options. If one way does not work, 
try the other. (A UNC path is set by browsing through My Network Places, or 
Network to locate the main CFS folder.) 

x. Do a test transfer. The easiest way is to go to Miscellaneous Estimator, enter one 
of something and attempt the export. Remember to include a customer name. 

y. The setup in QuickBooks for this interface application can be viewed by logging 
into QuickBooks as an administrator and going to Edit> Preferences> Integrated 
Applications (on the left)> Company Preferences> Highlight the CFS QuickBooks 
Application. The window should look something like this depending on your 
version of QuickBooks. Errors may happen if the settings are incorrect. 

 

 
 

Properties in a single user environment….  Properties in the multi-user environment… 
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i. Regarding the user in the multi-user environment, the user does not 
necessarily have to be an “admin”. But it does need to be a user who has 
permission to view, or, view and make changes to the Chart of Accounts. 
(This will not be a security issue because the interface just needs access 
to view the COA and associate accounts with items. There is no 
mechanism for making changes to the COA.) 

    

 Installation checklist 
 

1.  Interface programs installed in the local CFS> Apps> QB_Interface folder.  
(a) The CFS and Apps folder may be named something else but the folder the 

interface is installed in must be named “QB_Interface”. Interface files are: 
(i) CPANEL.exe   [Control Panel] 
(ii) CFSSetupMaintenance.exe 
(iii)  ExportCustomer.exe  [Creates the QB customer.csv file] 
(iv)  ImportEstimate.exe  [Imports accXml.xml file into QB] 
(v) AccXmlWrapper.exe  [Launched when Export to QB is chosen] 
(vi) Customer.csv    

(1) ExportCustomer will export the QB customers to create this file 
(vii) Sales_Reps.csv 

(i) See instructions below. 
(viii) Last_invoice.log 

(1) This file is created by AccXmlWrapper and stores the last invoice number 
transferred from CFS. The program reads this file to possibly generate a 
warning dialog box that an invoice has been transferred to QB previously. 

(ix) csvReFormatApp.exe  
(1) In order to import an Excel file of products intended to be imported into 

QB that has been saved in the csv format, this file needs to be 
reformatted a certain way. You can reformat it by running this 
reformatting app on the file. You can also drag and drop the file on this 
app and it will create the reformatted file. If you want to view it after 
reformatting, do not open the file in Excel again as this will reverse the 
reformatting. Instead, right click it and open with Notepad.  

 

2.  The control panel needs to be setup appropriately with the CFS location being the 
main CFS folder for sharing data which may be on a server. 
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3.  The enterprise.xml file should be in the local CFS folder and configured 
appropriately. It needs a line independent of a settings group similar to the 
following example. This path is user defined but a folder named “QB_Interface” has 
to be at the destination of where this path points to. The following is a typical 
enterprise.xml configuration. Notice the last line that defines the location of the 
QB_Interface folder. 

 
(a) Note: The Apps can be in whatever order you prefer on the menu. If you do not 

intend to use an App you do not need to include that <settings> group. 
 

<settings> 
<xmlfilepath>C:\CFS\Apps\XML_Reader_App\XMLReader.xml</xmlfilepath> 
<xmlexecpath>C:\CFS\Apps\XML_Reader_App\cfs-xml.exe</xmlexecpath> 
<sda_menu_name>Export to XML & View with XML Reader App</sda_menu_name> 
<sda_icon_name></sda_icon_name> 
</settings> 
<settings> 
<xmlfilepath>C:\CFS\Apps\Inventory_Analyzer_App\InventoryAnalyzer.xml</xmlfil
epath> 
<xmlexecpath>C:\CFS\Apps\Inventory_Analyzer_App\InventoryAnalyzerApp.exe</x
mlexecpath> 
<sda_menu_name>Export to XML & Run Inventory Analyzer App</sda_menu_name> 
<sda_icon_name></sda_icon_name> 
</settings> 
<settings> 
<xmlfilepath>C:\CFS\Apps\Commission_Assistant_App\CommissionAssist.xml</x
mlfilepath> 
<xmlexecpath>C:\CFS\Apps\Commission_Assistant_App\CommissionApp.exe</xml
execpath> 
<sda_menu_name>Export to XML & Run Commission Assistant 
App</sda_menu_name> 
<sda_icon_name></sda_icon_name> 
</settings> 
<settings> 
<xmlfilepath>C:\CFS\Apps\QB_Interface\Export.xml</xmlfilepath> 
<xmlexecpath>C:\CFS\Apps\QB_Interface\AccXMLWrapper.exe</xmlexecpath> 
<sda_menu_name>Export to QuickBooks</sda_menu_name> 
<sda_icon_name>C:\CFS\Apps\QB_Interface</sda_icon_name> 
</settings> 
<qbpath>C:\CFS\Apps\</qbpath> 

 

4.  If CFS is on a server there needs to be a CFSSetup.dat in the server CFS folder. This 
file is in addition to the normal CFSSetup.dat in the local CFS folder. It is critical that 
the data path in these files are correct for CFS & QB syncing features to work 
correctly. They should be identical. 
 

5.  InterOp.exe needs to be located in the main CFS data folder and in the local CFS 
folder. 
 

6.  APF.exe should be in the local CFS folder.  
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Sales_Reps.csv 
 
If you would like to use the option to be able to select a sales rep’s initials during the 
export process, there needs to be a file name Sales_reps.csv in the 
C:\CFS\Apps\QB_Interface folder. A sample file of this name is normally included in the 
installation. Right click on it and open it with Notepad. It contains only two fields, the 
sales rep’s initials and the sales rep’s name, separated by a comma. Enter the initials, 
comma, and name on separate lines for each sales rep. Do not include spaces. Do not 
have empty rows. It is necessary to keep this file name and this location. 

 
(a) If the file does not exist, it can be created by entering the information into any 

word processing program or spreadsheet. Choose Save As with the file type set 
to a csv file. If you type it in Notepad it will automatically be a .txt file of which 
you can just rename to have a .csv extension. 

 

Import of QB customers into the CFS contact 
center - semi-automatic & optional 
 
If you have some customers in QuickBooks, maybe some repeat customers, that you would like 
to import into CFS, there is a semi-automatic way of doing this.  
 

1. Open the QB_Interface folder and double click the ExportCustomer.exe application file. 
(This is just a direct way of doing what clicking the button “Refresh list of QB 
customers” does on the job export window. So if you clicked that button recently you 
probably don’t need to export again.) It exports the QB customer list into a format that 
CFS can recognize and read to make the customer information available to save in CFS. 

 
2. When prompted for the Export Folder, make sure the path is set to where the file will 

get exported. This needs to be your QB_Interface folder. In a standard installation the 
path is C:\CFS\Apps\QB_Interface. Then click Export. This might take a few minutes if 
you have a large file. 

 
3. The exported file will be named customer.csv. It needs to be copied to the root of the 

main CFS folder and renamed to SDA_CUSTOMER.csv. 
 

4. Run CFS> Tools> Miscellaneous Estimator and stop at the Input Customer information 
window. Put a checkmark in the box next to “Search Special Customer File” and your list 
of QuickBooks customers should appear. The program accesses the CFS customer list 
when the checkmark is absent and accesses the exported QuickBooks list when the 
checkmark is present. 

 
5. Double click a customer to load the information into the fields. Edit if necessary and 

click Save. This saves the entry in the CFS contact center and at the bottom of the 
displayed list. Notice the checkmark is gone and the CFS list is displayed. Even though 
they are not displayed in alphabetical order, a customer can be found quickly by typing 
characters into the search window just to the right of the Save button. 
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Troubleshooting Installation 
 

1. When first trying to establish the connection, a message pops up that the program 
cannot open QuickBooks because it is already open. 

a. This solution worked on a Windows 7 computer. 

i.  Uninstall the interface. Turn off the User Account Control and reboot. 
Reinstall per the directions by right clicking on Setup.exe and choosing to 
run as an admin. When running CPANEL.exe and get to the point where 
you will be opening QuickBooks, start it the normal way (Not running as 
admin as in the normal directions.) 

ii. You could experiment without turning off the UAC, install setup as 
admin but run QuickBooks the normal way. 

b. This solution worked on a Windows 8 computer 

i. UAC was on 

ii. Installed Setup.exe in the regular mode, not as an administrator.  

iii. Use the Shortcuts folder option otherwise it tried to open QuickBooks a 
second time when attempting to export an estimate. 

2. Error message: “Cannot connect to QuickBooks company file.”? 
 

a. There are several causes for this message depending on your Operating System 
and how the computer is configured. Try whichever of the following you think 
could be applicable. 

b. The number of QB users may be maxed out. If this is the case, a user will need to 
log out before another user can log in. 

c. The path to the QuickBooks company file may be too long for compatibility to 
the interface. Check your path by striking the F2 key on any QuickBooks window. 
It has worked at three levels down, i.e. C\Shared\QuickBooks\Company 
File.QBW, when it would not work previously when there was one more level. 

d. On some computers, the connection only works via a mapped network drive 
while on others, it only works via a UNC path. 

e. If there is more than one company file, the appropriate company file may need 
to be open in order for transfers and/or maintenance procedures to work. 

f. The QB company file may have been moved or renamed. Verify the path and 
name by pressing F2 in QB and viewing the path. Now go into CFS>Update 
Master File>Accounting tab and open the Control Panel. Click OK past the 
message that it could not connect. View the path to the QB co. file. If it is 
incorrect, first make sure all users are logged out of that co. file, and then 
browse to it to reset the path. You may be able to just manually type the new 
path or file name in the field and save. (If the Control Panel does not open, go to 
Computer and browse to your local QB Interface files, probably 
C:\CFS\Apps\QB_Interface and double click the CPANEl application file.) 

g. The Interface application may not have permission to access the QB company 
file, or, it may not have permission to log into QB automatically. Log into QB as 
an administrator in single user mode. Go to QB>Edit>Preferences>Integrated 



  Page 11 of 50 

Applications>Company Preferences. Make sure there is NOT a check mark in 
“Don’t allow any applications to access this company file. 

i. Under “Applications that have previously requested access to this 
company file”, highlight the “CFS QuickBooks Application” and click 
Properties.  

ii. The user does not necessarily have to be an administrator. But it does 
need to be a user who has permission to view, or, view and make changes 
to the Chart of Accounts. (There is no need for concern, changing the 
COA is not part of the Interface features. The Interface just needs access 
to view it and associate accounts with items.) 

h. Jobs transfer when QuickBooks is closed but not when it is open.  

(i) Uninstall the interface according to the instructions in this manual. Then 
reinstall the interface per the normal installation instructions. 

 

 
3. When transferring a job from CFS to QB, with QB running, the interface tries to open 

the company file again. This solution may work for any circumstance where using the 
Interface apparently triggers QB to try to open a second time. 

a. Go to Edit>preferences>general>take checkmark out of  "Keep QB running for 
quick startups" 

i. Here are some other processes that keep running sometimes:  
1. Right-click the Windows taskbar and select Task Manager.  
2. Click the Processes tab.  
3. End any of the following QB-related processes if they are listed. 

(Select each process and then click End Process. ) 
a. QBW32.exe 
b. QBHelp.exe 
c. QBUpdate.exe 
d. Support.exe 
e. Mrtmngr.exe 
f. QBdagent2002.exe 
g. QBdagent2001.exe 
h. QBdagent.exe 
i. Axlbridge.exe 

 
b. If the problem persists, reboot and try again 

 
c. If the problem persists, turn off the UAC, reboot, uninstall the interface, and 

install it again making sure it is installed properly for the OS. 
 

d. If the problem persists, turn off the UAC, reboot, uninstall the interface, and 
install it the usual way (in Win7 or later, right click and run as admin). However, 
when opening QuickBooks, do not right click and run as administrator per the 
usual directions. Just run it the normal way by double clicking the short cut. 

 
e. If the problem persists, a folder named “Shortcuts” may need to be created in 

the QB_Interface folder and a checkmark put in the box next to Open Folder near 
the bottom of the Save Accounting Estimate window (same as the 
AccXmlWrapper.exe window). This will add one more step but may solve the 
problem. It causes the application to get launched by a user, rather than another 
application which seems to be the cause of the problem with some operating 
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systems. Create shortcuts for the following applications and save them in the 
Shortcuts folder. 

i. ImportEstimate.exe and name it “Export job to QB” 
ii. ExportCustomer.exe and name it “Refresh list of QB customers” 
iii. CPanel and name it “Open the Control Panel” 

 
4. When trying to install QBFC8, this error occurs: Error #ID_STRING7#, User does not 

have permission to install programs.  
a. Log in as an administrator and try again. 
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To uninstall the interface 
1. When logged in as an administrator, go to QuickBooks> Edit> Preference> Integrated 

Applications> Company Preferences> highlight the interface option and click Remove. 
 

2. On your computer, go to Start > Settings > Control Panel > select Fence Software 
QuickBooks Application and press Remove 

 
3. If you plan to reinstall, just delete the file named Settings.txt. If you are not planning to 

reinstall, you could delete the entire QB_Interface folder. 
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Data Setup - QuickBooks 

1. Tracking Inventory 

a. If you plan to track inventory, make sure you have this option turned on in QB. 

2. Unit of Measure 

a. The Unit will import from CFS. If you would like the Unit to display in QB, the 
Unit of Measure needs to be turned on. In QB 2010 (and maybe other versions) 
go to Edit> Preferences> Items & Inventory> Company preferences> Enable Unit 
of Measure> choose Single unless you need it set to Multiple. Make sure the unit 
designations in CFS are consistent throughout the master file. See CFS setup 
requirements for more information about this issue. 

3. Customize the Estimate form in QB 

a. Make sure your QB is setup so you can create estimates. 
b. You can take advantage of some interface functionality if the estimate form in 

QB is setup to include the Sales Rep field. The sales rep can be chosen during the 
import process and populate this field.  

c. If the “Ship To” address block is on the QB estimate form, the CFS Job 
Information will populate into it.  

4. Chart of Accounts 

a. Verify the Chart of Accounts meets your needs: 
i. There has to be at least one income account (critical to Level 1&2), COGS 

account (critical to Level 2 only), and Inventory account (critical to Level 2 
only). You may choose to have sub accounts in each of these types. 

b.  Several other income accounts are recommended 
i. “Contra Income” for recording discounts. 
ii.  “Freight”, or a name of your liking, for recording freight charged for 

deliveries to customers. 
iii.  An account to record installation labor income. 

5. Required Items 

a. Some Items are required to be in the Item List whether you plan to track 
inventory on hand or not. The description of each may be whatever you like. 

i. Freight (Type is Service) This is delivery charge to the customer. 
ii. Discount (Type is Discount) This is a sales discount to customer. 
iii. Labor (Type is Service) This is installation labor. 
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CFS Data Setup 

Introduction 
 
The Interface setup is usually done primarily by a representative of Software Design Associates 
with cooperation from the client. The list of items in CFS is called the Master File and is 
equivalent to the Item List in QuickBooks. The interface matches the Part Number of items in 
the file exported from CFS to the Item Name/Number in the QuickBooks Item List in order to 
synchronize the data when exporting a transaction from CFS and importing it into QB. 
 
These instructions are detailed in this manual so it can serve as both a QBI user manual and an 
SDA employee manual. So if you do not understand some of the directions, do not be overly 
concerned as it is probably something only an SDA representative would understand anyway. 
 

There are two basic levels to the interface setup 
 

• Level 1 setup makes it possible to send transactions to QB without tracking 
inventory. It should be setup even if tracking inventory is the ultimate goal. This is 
for two reasons, so transfers can be made before tracking is viable (i.e. actual counts 
have not yet been recorded in QB), and, in the long term, for some transfers where 
tracking is not needed. 
 

o There is no need to have Part Numbers in the items in CFS. The interface will 
assign a generic Part Number based on the word “CUSTOM” to each item when 
the transaction is exported to QuickBooks.  

o At the Export to QB window in CFS, the Detailed Inventory Tracking Mode box 
must NOT contain a check mark. The default can be set in Update Master File> 
Accounting. 

 
• Level  2 setup is the configuration needed in addition to Level 1that makes it 

possible to track inventory.  
 

o The Part Number fields in the CFS items need to have entries, and these entries 
have to be identical to the Item Name/Number in QuickBooks. The CFS Master 
File items can be exported and used to populate the item list in QuickBooks. If 
this preferred method can be employed, it guarantees the IDs will be the same. 

o At the Export to QB window in CFS, the Detailed Inventory Tracking Mode box 
MUST contain a check mark. 
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Level 1 setup details 

1. Sales Tax 

a. The Sales Tax templates in CFS should be setup to replicate the Sales Tax 
options in QB. The interface is going to ignore the sales tax associated with a job 
coming from CFS because QB will be handling the application of the correct tax. 
The reason to have the sales taxes replicated in CFS is so the bottom line price of 
the job is the same total as it will be in QuickBooks.  

2. Part Numbers 

a. When a job is exported to QB in the non-inventory tracking mode, the system 
assigns a generic Part Number to each line item on that job. The computer 
generated Part Number is independent of what the item actually is or the entry, 
if any, in its Part Number field. This generic Part Number will have the word 
CUSTOM as its base. 

 
b. These CUSTOM items need to be added to the QB item list as Non-Inventory 

Parts before job transfers begin. This is because if a CUSTOM item gets added 
on-the-fly on a job with a discount, the price may be incorrect. If the item is 
already in QB at the time of transfer, this potential problem can be avoided.  
Also, the default QB item Type is “Inventory Part” but CUSTOM items have to be 
Non-inventory Parts. If a CUSTOM item is added on-the-fly, it is easy to forget to 
change that setting to a Non-inventory Part. This is critical for proper account 
posting.  

 
c. CUSTOM items are re-used each time a job is imported from CFS in this non-

inventory tracking mode. Each CUSTOM item name will be appended by a user 
defined character designating a type of fence. Since there can only be one line 
item of each item name/number on any given transaction, the interface will 
append a number to the base. For example, in an imported Chainlink Scratch 
Builder job, the Item Name of the first item would be CUSTOM-C, the second 
CUSTOM-C 1, the third item CUSTOM-C 2, etc. 

 
d. Recommended fence type item designators and resulting Item Name/Numbers 

are listed here below. It is best to stay with the S, P, and O because those Scratch 
Builders will automatically use those designators on the items they fabricate. 

 
i. S for Chainlink   CUSTOM-S, CUSTOM-S 1 …CUSTOM-S 30 
ii. P for PVC/Vinyl fence items CUSTOM-P, CUSTOM-P 1 …CUSTOM-P 12 
iii. O for Ornamental   CUSTOM-O, CUSTOM-O 1 …CUSTOM-O 12 
iv. W for Wood items  CUSTOM-W, CUSTOM-W 1 …CUSTOM-W 12 
v. X for Wire Panel items  CUSTOM-X, CUSTOM-X 1 …CUSTOM-X 12 
vi. M for Miscellaneous items CUSTOM-M, CUSTOM-M 1 …CUSTOM-M 12 
vii. No designator for Write-in entries* CUSTOM, CUSTOM 1 …CUSTOM 5 
viii. R for Residential SB  CUSTOM-R, CUSTOM-R 1, ….CUSTOM-R 6 

1. The CUSTOM-R items are only needed if the Residential Scratch 
Builder is going to be used. No matter the account designator, it 
will use CUSTOM-R for fabricated gates and posts. 

 
e. Each fence type has a different designator so you can post the sales amounts for 

each kind of fence to separate income accounts. If you intend to have the sales 
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amounts for all fence types posted to the same income account, you would 
associate the same income account to all the CUSTOM items. Or, you could 
assign the same fence type designator to all the Master File items. However, 
keeping the different designators would make it easier in the future if you ever 
wanted to start recording sales to different accounts. 

 

3. CFS Write-In Entries*: 

 
i. CFS Write-In Entries are created by the user to sell items that are not in 

the Master File. To accommodate for CFS Write-in entries, the interface 
assigns a Part Number of CUSTOM (with no fence type designator). The 
Interface will use this same Part Numbering scheme in the Scratch 
Builders, Miscellaneous Estimator, or Cash Register.  

 
b. Note: QuickBooks does not allow the creation of Non-inventory Parts with the 

same Item Name/Number as an Inventory Part that has been made inactive. 

4. Getting the CUSTOM parts into QuickBooks 

 
a. You can manually enter the CUSTOM items into QuickBooks, or, use a semi-

automatic process explained next.  For proper function, do not include Unit of 
Measure (U/M) entries in CUSTOM parts.  

i. Create one of each type of custom item in the QB item list 
ii. Export the list to Excel 
iii. Isolate only the custom items 
iv. Create as many copies of each one as needed 
v. Create a column with the numbers that will be appended 
vi. Combine the Part Number and the numbers field into one 
vii. Copy and paste values only 
viii. Create another column and use the Trim formula to remove extra spaces 
ix. Remove unneeded columns 
x. Import into QB using the File> Utilities> Import> Excel Files> Advanced 

Import option. 
 

1. Tip: The income account name field in the Excel file must be no 
longer than 23 characters long. If the account is a sub-account, 
the total number of characters for the sub-account is also 23. 
After the items are imported, the account names can be changed, 
so, if the character limit is an issue, a way to deal with this is to 
edit the account names to be short enough, import the items, and 
edit the account names back to their original descriptions. 
 

2. Caution: There is a bug in some QuickBooks versions that will 
cause QuickBooks to freeze up during the map creation routine. 
See the troubleshooting section near the end of this manual if this 
problem occurs, or, follow the directions for the solution in order 
to avoid the possibility of it happening. 

 
3. Caution: Custom items must not have an assigned Unit of 

Measure. Also make sure there is NOT a check mark in the box 
next to “This item is used in assemblies or is purchased for a 
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specific customer:job.” See the troubleshooting section of this 
manual for more detail. 

 
4. Caution: If it is necessary to use Misc Estimator to transfer 

CUSTOM items into QB, disable U/M while doing so and enable 
again afterwards. Otherwise it will add a U/M to the items. 

5. Preparing for sales account designations of items 

a. Determine in advance which groups of items in the CFS Master File will be 
designated to the same fence type and subsequently to the same sales account in 
QB. 

i. One way to do this is to go to Update Master File, Open Record, browse 
through the items and make notes of the various boundary record 
numbers. 

ii. Another way is to print the Master File to a pdf and browse the printouts 
for the boundary record numbers. 

iii. You could also use InterOp to export the Master File to Excel and look up 
the boundary record numbers. 

6. Backup your primary data files. 

a. These files are in the main CFS folder. They are the MASTER.0 and all the files 
beginning with the word SAVE. You can view and access the location of the data 
files by going to the CFS Utilities tab and clicking System Information. 

 

7. To associate the designator to the items in CFS: 

a. Set pointer 20 to “1” to enable the option. 
i. To do this go to Update Master File, Settings tab, choose Change Pointer 

Settings, Pointer.0, a single pointer, 20, set it to “1”, click next and close. 
b. Go to Update Master File and type “INTERNAL” and enter. This is not a menu 

choice but you should see it show up near the bottom of the window when you 
type it. 

i. On the Internal Special Functions menu choose “LOW LEVEL change”. 
ii. Enter a beginning and ending record number for a group of records and 

click OK. 
iii. At the question “Which MF$()/MFN() subscript to change?” type “22” and 

enter or click OK.. 
iv. At the “Enter MFS$(22)=” type the fence type designator and press Enter 

or click OK. For example, enter a “W” for the wood items as per the table 
listed earlier. Do not include the quote marks. 

v. Click Yes when prompted “Are you sure?” 
vi. Repeat for each group of records making sure that all items in the master 

file have a fence type designator. 
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Level 2 setup – tracking inventory 
The QBI comes with a utility program called InterOp. With InterOp, the Master File can be 
exported to a .csv file and opened in a spreadsheet program like Excel. Changes can be made to 
certain fields and then imported back into CFS. The details of InterOp functionality is in the 
separate CFS Enterprise Edition (CFSE) manual. InterOp is very useful for quickly making the 
changes needed in the CFS Master File, and later, to prepare the items exported from the Master 
File for importing into QuickBooks. These directions include how to make the changes without 
InterOp and with InterOp. 

1. Labor Records  

 
a. While it is useful to include labor as a component in CFS for calculating the cost 

and subsequent selling price of an assembly, whether that assembly is pre-
defined or a product fabricated as needed by the estimating program, it is 
usually not appropriate as a component of an assembly in QB. In QB, the 
components should only be materials because the labor is accounted for when 
people are paid to do the work.  

 
b. To ensure that fabrication labor is not transferred to QB as the component of an 

assembly, the word “LABOR”, or “Labor”, should be in the description of these 
items in CFS. Items containing the word labor will not transfer to QB – whether it 
is a component of an assembly or not. This should not be confused with the 
installation labor. This is the Labor entry listed separate from the materials and 
only appears as a result of entries in the Labor module. This Labor does transfer 
to QuickBooks. 

 
c. There are labor items in CFS for cutting chainlink posts from full lengths that are 

normally named “Cutting Cost”, cutting lumber such as “Lumber Cross Cut”, for 
fabricating chainlink gates named “Welding Cost”, for fabricating PVC and 
Ornamental profiles like “Routing Charge”, “Punching Charge”, etc, and more. 
This kind of labor is used in the CFS fabrication process in order to price 
products correctly. Or sometimes, this labor is used as components of pre-
defined assemblies. Either way, the fabricated product or pre-defined assemblies 
will transfer into QB as an assembly cut without the labor component if these 
directions are followed.  

 
d. There are a couple ways to add the word labor to multiple items all at once. The 

word can be in either the Item field or the Description field. Open Record or the 
Change Descriptions feature in Update Master File can be used. If you have and 
use InterOp to update the entries, remember that the words in the Item field 
cannot be imported back into CFS so add “Labor” into the Description field. If 
the word “Labor” is already in the item field it does not need to be added to the 
Description field. It just needs to be in one or the other field. 

 
e. If you want to have some labor available to be listed on the material list after 

import into QB, make sure it does NOT contain the word “Labor”. You could call 
it a charge or a fee.  
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2. Alert!! PVC and/or ornamental fencing fabricator module users 

 
a. It is critical for proper inventory tracking to have I (“I”nventory) flags in the 

profile, bottom rail inserts, and lattice items. For example, if you do not have an I 
flag in a 5X5X192” profile and cut a 96” post from it, the entire piece will be 
deducted from inventory for each post. With an I flag in place, only half the piece 
will be deducted. There is more to know. See the CFS manual chapter on setting 
up the PVC and/or ornamental fabrication modules for more detail. 
 

b. Also, if vinyl U-channel is used to cover the tongue or on the sides of the lattice, 
the smaller pieces are normally setup as assemblies to connect them to the raw 
material. If a vinyl fabricated job is exported to QB in the summary mode, there 
will have to be enough U-channel assemblies on-hand in QB for the job to 
transfer. These can be built directly in QB, or, a Miscellaneous Estimator job 
could be created with the desired quantity of U-channel assemblies. This “job” 
could be transferred to QB thus letting the interface force the builds for you. The 
estimate can then be deleted from QuickBooks. 

 
c. To add the I flags, go to Update Master File> Change Utilities> Change Flags. If 

you use InterOp, after importing the flags back into the Master File, you still 
need to go to “Change Flags” and go through the process of viewing each item 
and accepting the entry. This is so the program has the opportunity to create the 
Inventory Control Record that results from adding an I flag to an item. 
 

3. Unit of Measure 

 
a. If you turn the U/M option on in QB, (see QB setup instructions), the U/M on CFS 

transactions will be on QB transactions. If a unit is used on a CFS transaction 
that is not already setup in QB, QB only uses the first two characters and will 
truncate the rest. It is best if the units are already setup in QB to match all the 
possibilities coming from CFS, plus, if the units are setup in QB in advance they 
can be more than two characters long. 

 
b. You can setup unit descriptions in QB by loading any item and clicking the unit 

drop down menu to reveal the “Add new” option. The following unit descriptions 
are recommended with the unit description in parenthesis being the same as the 
unit description in CFS: 

 
i. Each (Ea.)   Pallet (Plt.)  Set (Set) 
ii. Foot (Ft.)   Roll (Roll)  Hour (Hr.) 
iii. Pair (Pr.)   Coil (Coil)  Bundle (Bundle) 
iv. Box (Box)   Gallon (Gal.)  Carton(Carton) 
v. Bag (Bag)   Quart (Qt.)  Package(Pkg.) 
vi. Cubic Yard (Cu. Yd.)  Pound (Lb.) 

 
c. These description formats are optional with the exception of “Ea.”. When CFS 

fabricates certain products it generates a unit description of “Ea.” that the user 
cannot change.  
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d. If the unit descriptions are not consistent in CFS you can use “Change 
Descriptions” to update them. Or you can use InterOp to export the Master File, 
update the Units, and import back into CFS.  
 

4. Verify assemblies are flagged correctly 

 
a. The flags "U", "A", and "E" should only be in items that are setup as assemblies in 

CFS. The U flag stands for (U)n-assemble so components are accounted for in 
regards to inventory tracking purposes. “A” stands for a weighted (A)verage so 
the program auto figures the markup on the assembly based on the markups on 
the component parts, and E stands for (E)xplode causing the components, not 
the assembly, to list individually on the output.  
 

b. If an assembly item in CFS contains a U flag, the interface will recognize the 
components and track inventory appropriately. If an assembly item does not 
contain a U flag, the interface ignores the components and treats it like a regular 
non-assembly item. This may be desired when an “assembly” is only setup for 
calculating the cost of an item. For example, the cost of a board could be setup 
as an “assembly” where the component is a quantity of a price per board foot. 
Another example is when a linear foot of fabric is setup with a component of the 
cost per square foot but you want to track inventory of the linear feet, not the 
square feet. In both these cases, there should be no U flag in the boards or 
fabric. 

 
c. The assemblies can be viewed, edited, deleted, and printed by going to Update 

Master File> Change List Price> Assemblies (Additional Pricing Functions). Print 
the list for referencing when reviewing or changing the flags.  

 
d. There is a utility feature in CFS to check for items flagged as assemblies but are 

not assemblies. Go to Update Master File >Check MASTER FILE & SAVE FILES for 
common errors> check for Unnecessary Flags. The report can be displayed on 
the screen or printed. 
 

e. Avoid having assemblies as components of assemblies if possible. If this is 
unavoidable, there will need to be enough sub-assemblies built in QB to have 
enough on hand to build the primary assembly, just like there has to be enough 
regular items on-hand to build an assembly. The sub-assembly can be manually 
built in QB, or, you can “borrow” the job transfer mechanism to automatically 
build them for you. Go to Miscellaneous Estimator, enter as many as you like and 
transfer the job. You can delete the estimate that gets created in QuickBooks but 
the built assemblies will be done.  
 

f. There are two ways to verify the assemblies are flagged correctly, without 
InterOp or with Interop. Checking with InterOp is much easier. 

 
i. To check without InterOp: 

1. Use either the list of assemblies printed from the assembly 
window or the APF.exe export for references when you go to Open 
Record or Utilities> Change Flags to verify flag settings. 
 

ii. If using InterOp to examine assembly flags, a list of the assemblies first 
needs to be exported to a text file for InterOp to read. To do so, open 
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your main CFS folder and double click on the APF.exe application file. 
Either export option will work. The file path is where the file will get 
created and needs to be to the same folder InterOp is getting launched 
from. Click OK. As soon as the working notification is gone when you 
have your cursor over the window, it is done exporting and you can close 
APF.exe. If you want to view the APF.txt file you can open it with Notepad 
or open it in Excel or like program. You do not need to open it for this 
process. 
 

1.  
 

iii. Now run InterOp and export the Master File with the Assembly 
Identification option. See the field that identifies if an item is an 
assembly and its associated flags. These flags can be changed and 
imported back into CFS. 

5. CFS Part Numbers 

 
a. Part Number requirements 

i. All items in CFS that will be included in transactions to be exported to 
QB, including fabrication labor items (even though they ultimately will 
not be imported into QB), must have a Part Number in their Part Number 
field. See character length restrictions below.  
 

ii. This can be done by going to Update Master File> Change Utilities> 
Change Source/Part Number. Or, 

 
iii. InterOp can be used to export the master file to a spreadsheet program 

such as Microsoft Excel where the Part Numbers can be entered and then 
imported back into CFS. Do NOT have an APF.txt file in the CFS folder 
when doing this so assemblies WILL be included. Use the Assembly 
Identification export option.  
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iv. Most assemblies need to have Part Numbers but the items with an E flag 

for “E”xplode do not. These are typically setup to combine items for a 
menu choice but the components list separately on the transaction. In 
other words, by the time the job is figured, those assemblies are not 
assemblies anymore. Only the components of exploding assemblies need 
Part Numbers. 

 
v. If some items that will be on transactions being imported from CFS are 

already in the QuickBooks item list, there are two choices. Either put the 
item name in QB into the Part Number field in CFS, if it fits CFS 
requirements, or, change the item name in QB.  

1. QuickBooks provides several methods for editing the item list 
including the item name/number en masse. See the QB tutorials 
and directions for more information. 
 

 
b. Part Number Restrictions 

 
i. While it is recommended to only use letters and numbers as Part 

Numbers. The following characters are not recommended but acceptable 
– period, dash, underscore, and forward slash (/). The reason these 
characters are not recommended is that when a person is loading a 
specific item by typing in the Part Number, he or she then has to 
remember to type these special characters along with the rest. Also, it 
makes it longer and introduces one more variable that could throw things 
off. Spaces will cause an error to occur when reading a pricing file for 
automated pricing updates so they should be avoided along with any 
special characters not listed above. 

 
ii. The Part Numbers of “FABRICATED”, “FAB-POST”, “FAB-PIECE”, and 

“SECTION” have special meaning in the interface export so do not use 
them for a Part Number in the CFS records. 

 
iii. The Part Number “CUSTOM” is used for CFS Write-in entries and for any 

item on a job sent to QB in the non-inventory tracking mode, so normally 
it would not also be in the Part Number field. However, if you wanted to 
track inventory on some parts but then have some items not track AND 
channel them to the same reusable CUSTOM items in QB, you could put 
“CUSTOM” in the items’ Part Number fields. 

 
c. Special consideration when the Source Number is longer than twelve 

characters, and, you want to use that number as the Item Name in QB: 
 

i. When it comes to products only purchased from one vendor, which is 
often the case with PVC, ornamental, and wire panel fencing, people 
usually use the vendor’s Part Number (the Source number in CFS) as the 
primary, common number in CFS and Item Name in QuickBooks. If the 
Source Number length is equal to or less than12 characters long, it can be 
copied or moved into the Part Number field in CFS. 
 

ii. However, sometimes the Source Number is longer than 12 characters. The 
Source Number can be expanded to accommodate up to fifteen 
characters but the Part Number cannot. To resolve this conflict, you can 
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put the word “SOURCE” in the Part Number field. (The program is not 
case sensitive regarding the word “SOURCE”.) When the program reads 
the word “Source” in the Part Number field, it will use the Source Number 
instead of the Part Number as the Part Number on the output. 
 

iii. The way to expand the Source Number from a maximum of 12 to 15 
characters is to put a “~15” in the first field of the two part Source 
Number. This also makes the expanded Source Numbers easy to identify. 
 

6. Preparing the CFS Master File export for Populating the QuickBooks 
Item List 

 
a. Export the CFS assemblies to a text file so the Master File can be exported in a 

way that excludes assemblies. It is critical that assemblies be excluded from the 
list of non-assembly items to be imported into QuickBooks. (See a separate 
section regarding the proper way to transfer assemblies from CFS to QB.) 

i. To export the assemblies, run the APF.exe program as described above 
under the section related to verifying assembly flags.  

 
b. To export the file for use in populating the QB item list, run InterOp and choose 

the option to “Export to Accounting CSV”. This option will exclude the 
assemblies if the APF.txt file is present in the local CFS folder as described 
above. This is very important so double check that assemblies are indeed being 
excluded before proceeding. 
 

c. Keep your commonly sold items and delete all the items that do not need to be 
imported into QuickBooks. Keep in mind that items not in QuickBooks can be 
added during a job export. However, it is best to keep that circumstance to a 
practical minimum. It is recommended that if you have a plug & play ornamental 
or PVC module such as Ameristar Ornamental or Bufftech PVC, you can either 
pick out the commonly sold of these items to keep, or more simply, delete the 
entire item block and let the interface add them during exports to QB. If you 
fabricate PVC or ornamental, keep the appropriate raw material. Also delete any 
labor items that contain the word “LABOR” or “Labor”. Save the file. The file 
name “ItemsForQB” is used for this example. 

 
d. Identify each group of Inventory Part items (you may or may not have more than 

one group) that will have the same asset, cost of goods sold, and income 
accounts associated with them. Manually add one item from each group into the 
QuickBooks item list in the manner you prefer. Usually you would be choosing 
Inventory Part, entering the Item Name/Number, if it is to be a Subitem, the Unit 
of Measure, the Description for Purchase Information and Sales Information 
(usually the same), Cost, Sales Price, COGS account, Income Account, Asset 
Account, and if it is taxable. Other fields are optional.   

 
e. In QuickBooks, export the item list to Excel, preferably without the directions 

cover worksheet. Delete all but the items you added manually in the previous 
step. This provides you with the format necessary for importing the entire group 
or groups of items from CFS. 

 
f. Using the tools within Excel, format the ItemsForQB file to the format of the 

Excel file exported from QuickBooks in the previous step. When that is done it 
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should be ready for import into QuickBooks. You could break out categories 
onto separate worksheets if you like. 

7. Importing the items exported from CFS into QuickBooks 

 
a. Make a backup of your QuickBooks company file. 

 
b. In QuickBooks go to File, Utilities, Import, Excel Files, Advanced Import. Browse 

to the file readied for import, select the worksheet if necessary, setup a mapping 
or choose a pre-setup map, and Import. If items fail to import, choose to create 
an error log file and view it with Notepad or other program. Make the 
appropriate adjustments and try again. (In some versions of QB, when creating 
the import map and associating fields in QB with the import file fields, QB will 
lock up. To avoid this, click on the label of the first QB field name before clicking 
in the field where you choose the matching import file field. This normally only 
needs to be done for the first field match.) 

 
c. Ideally you would do a physical inventory count and update QB before using the 

interface in the inventory tracking mode. This is for two reasons. Aside from the 
fact that the beginning counts need to be correct for any subsequent counts to 
be correct, the interface will not let you export a job in the tracking mode if it 
contains an assembly and there is not enough components on hand in QB. 

 
d. You can transfer jobs in the non-inventory tracking mode until you have a 

chance to enter the current counts in QB.  
 

i. The default for the tracking versus non-tracking mode is set in Update 
Master File on the Accounting tab. 

ii. When the counts are corrected in QuickBooks, set the default 
appropriately. 

8. Recreate the CFS cross reference table 

a. After the installation is complete and the commonly sold items have been 
imported into QuickBooks, go into Update Master File in CFS and force the 
recreation of the cross reference table for the Record, Source, Part number fields. 
This can be done by selecting Import another master file, then closing that 
window, and quitting Update. 

9. Importing assemblies into QB 

a. Assemblies do not have to be imported into the QB item list during the setup 
process. When a job is being transferred, the interface will detect any assemblies 
not in QB already and add them. 
 

b.  If you have quite a few commonly sold assemblies, or otherwise prefer to get 
them in QB prior to exporting jobs, you can “borrow” the job transfer 
mechanism to transfer one of each. It will also build them, but that’s okay 
because the next real job that gets transferred that contains one of those 
assemblies will use the built one before building more. 

 
i.  If you would like to do this, go to Miscellaneous Estimator, enter as many 

as you like and transfer the job. You can delete the estimate that gets 
created in QuickBooks but the built assemblies will be in the item list. 
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c. Tip: There is a way to circumvent the auto-building of pre-configured 

assemblies.  This approach would probably only be used in special 
circumstances. If the item is in QuickBooks as an assembly but just a regular 
item in CFS, the interface will not “know” it is an assembly in QuickBooks and 
therefore not try to build it during the export. 

 
i. Ramifications are that the user will need to manually trigger the builds in 

QuickBooks, albeit at the time of the users preference, and, the cost and 
selling price of the item in CFS will be determined like a regular item 
therefore the cost will need to be calculated by the user unlike if it was 
an assembly, under which circumstance the program would calculate the 
cost. 
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Daily Activity 
The interface is flexible and powerful so it is important to 
understand your options. This flowchart covers inventory 
tracking options. The second flowchart focuses on the workflow. 
 

 
 
Means for tracking jobs in QuickBooks back to CFS: If a CFS estimate has a job number 
assigned to it, and the job gets saved in CFS after assigning the job number, that job number 
will automatically be included on the memo line of the job exported into QuickBooks. If the CFS 
estimate is converted into a CFS invoice before exporting, the CFS invoice number will 
automatically be included on the memo line.  
(Optional: The CFS invoice could be handed to the customer immediately but the transaction 
not exported into QuickBooks until later.) 

When exporting from CFS (or VFT) 
(Inventory tracking or no inventory tracking) 

Interface makes use of reusable non-inventory 
items in QB with a name/number of CUSTOM, 
CUSTOM 1, CUSTOM 2, etc. when creating the 
QB estimate. Components of assemblies and 
fabricated items are ignored. 
 
 

All items are tracked for 
inventory purposes. Any 
assemblies and/or program 
fabricated parts will be built 
in QB.  

QB estimate 
may be 
converted to 
sales order or 
invoice. 

User would ONLY convert 
this QB estimate to a sales 
order or invoice if he or she 
does not want the items 
added to QB as permanent 
items. 

Usually track 
inventory 

When this job is imported 
into QB, it would 
immediately be converted 
into a sales order or invoice, 
or, a PO & SO, or PO & 
Invoice, or just a PO if it is 
not intended to be a SO or 
Invoice in the future. 

Inventory tracking mode (off)  
For those who do not intend to track inventory at 
all.  
And for those that do want to track inventory, this 
mode is for un-sold jobs or jobs where all items are 
to be non-inventory items and you do not want 
them added to the QB item list permanently. 

Inventory tracking mode (on) 
For those that want to track the 
inventory of this job AND the job 
is SOLD. 
 

Never track 
inventory  
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Workflow 

 

 

1. User initiates job export from CFS in either 
inventory tracking or non-tracking mode. 

2. Window pops up for user to make choices. 
a. If neither job number nor invoice number is on 
the memo line, user can enter info in this field. 
b. User leaves CFS customer name in place or 
chooses from a list of customers already in QB. 
c. User has option to choose a sales rep if setup. 
d. User will have option to have the items go over as 
a Group in QB in order to have the subsequent 
option in QB to print the transaction with a one line 
description of the job rather than as an itemized 
list. 
 
User clicks button to initiate transfer. 

3a2. Job imports into QB and Estimate opens automatically if QB is running.  
Customer code, name & address, memo, & sales rep fields are filled in from 
earlier choices. User fills in more fields if desired. All sales taxes are dealt with 
solely by QB. Non-inventory tracked jobs would be converted into a SO or invoice. 
Inventory tracked jobs would be converted into a sales order or invoice, or, a PO 
& SO, or PO & Invoice, or just a PO if the job is not intended to be a SO or Invoice 
in the future. 
 

3a1. If inventory tracking is enabled, items not 
in QB are detected. A window pops up listing 
the items and user can change the default 
accounts if necessary - Income, Asset, COGS, 
and Item type. If defaults are not appropriate, 
change here, or, cancel the job, go to the 
Control Panel, change the defaults, then start 
the export again. 
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Daily Use Explanation 
Jobs can be exported from any of the Estimating module menus and the Cash Register reports 
menu. 

Exporting Level 1 Jobs 
Level 1 jobs can be exported to QB using the same method whether they are sold or not. Since 
inventory costs and counts are not being tracked and there are no assemblies, no special 
consideration is needed.   

Exporting Level 2 Jobs 
Sold Level 2 jobs need to be exported differently from jobs that are still just estimates at the 
time of the export. Unless there is some compelling reason to do otherwise, only export sold 
jobs and convert them into either sales orders or invoices before leaving the transaction. 
Once the job is in QB, immediately convert it into a Sales Order or Invoice.  
Next, choose “Export to QuickBooks” on the Export window.  
 

 

Customer name is required 
There has to be a customer name associated with the job before it is exported. (A notification 
will pop up if there is not.) The job could be exported using any name and then the correct 
customer/job name could be associated with it after it is in QuickBooks. If the customer name 
will be new to QuickBooks, QB will use its Quick-add feature to add the new name in its 
customer center. This is convenient because you do not have to first put the customer in QB 
before sending the job over. The drawback, which I will tell you how to overcome, is that while 
the address transfers into the address block on the transaction in QuickBooks, the Quick-add 
feature only saves the customer name in the Customer Center, not the address.  
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 A list of QB customers can be generated and made available to use in a drop down list by 
clicking the Refresh list of QB customers button. If the list is refreshed but you do not see an 
expected entry, close the export, save the job, close the module, and reopen the module, load 
the job and click to export again. Now the list can be viewed properly. 
 
Tip:  If the customer is going to be new to QuickBooks, or, the address block in QuickBooks 
needs to be updated, you can intentionally have at least one incorrect character on the 
street/mailing address line in CFS so there is something to change after it is in QuickBooks. 
Putting an X at the end would suffice. After the job is transferred to QuickBooks, remove the X 
from the address block. When leaving the transaction, QuickBooks will prompt if you want to 
update the customer file. Clicking “Yes” will save the entire corrected address to the customer 
file. Do not put the incorrect character(s) in the name because QuickBooks will add a new 
customer instead of just correcting the old one. Use the street address line instead. 
 
Warning: If choosing from the list of existing QuickBooks customers, all active jobs in 
QuickBooks must have unique names or the list will get truncated. See the troubleshooting 
section at the end of this manual for error details related to duplicate names and the quickest 
way to resolve the issue.  
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Sample drop down of existing QuickBooks customers: 
 

                                  
 
Memo Field: The contents of the Memo Field on the interface window will export into the memo 
field in QuickBooks. If you transfer jobs from the estimating modules and want a reference 
back to CFS, an option is to use the CFS job numbering system. If a job number is assigned and 
the job is saved prior to export, the job number will automatically be on the memo line. If the 
job is converted into an invoice in CFS first and then exported, the invoice number will show up 
in the memo field. The invoice number cannot be changed once it is in the memo field. 
 
When you click the Export to QuickBooks button, and there are no items new to QB, the QB 
estimate is created and will automatically open in QuickBooks if QB is running.  
 

.  
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The “Group” option 
 
The group option is included so reports can be printed in a summary format even though the 
itemized list still displays in the QB window. The interface will use whatever is in the CFS Job 
Description field as the default name of the group. The following is an example of a printed QB 
invoice when the group option had been chosen.  
 

 

 
Keep in mind QB groups are limited to 20 items or less so you could end up with more than one 
summarized group on a report. If this happens, one or both groups can be renamed if the 
default name needs to be more appropriate. Note: Descriptions can be up to 4095 characters in 
QB. The top message line can be longer than 4095 but would get truncated coming into QB. 
 
QuickBooks will not include the tax in the summary amount. Also, if there had been a discount 
printed separately, it will be on a separate line here. If you do not want the discount to list 
separately, choose the option in CFS to apply the discount to each line. 
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When job items are new to QuickBooks 
 
If one or more of the items in the CFS job are not already in QB an intermediary window will 
pop up for you to confirm or change the accounts to be associated with the items when the 
interface adds them to the QB item list. 
 

 
 
Note: Items new to QB are imported on the main level in QB. If you want them to be “Sub of” 
items you will need to do that within QB.  
 
If the default accounts for this particular job are not correct, you can change them here, or, you 
can cancel the export, go to the Control Panel…… 

 
 
….change the default accounts, Save, and initiate the export again. 
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If the job being exported is not sold yet - an estimate 
 
If inventory is normally tracked, and, you want to send an un-sold job to QuickBooks, it is 
important to turn off tracking so no assemblies or fabricated items inadvertently get built for a 
job that may never be sold. Turn off tracking on the export window by un-checking the tracking 
option. 
 
After exporting, the estimate in QB will show each entry as having an appended Part Number of 
CUSTOM-[], CUSTOM-[] 1, CUSTOM-[] 2, etc. Part Numbers can be suppressed from the printed 
estimate by changing the template design. Everything else will look just like the list of items on 
a report in CFS along with the same selling prices and you can print, email, etc. just like you do 
now. 

 
  
If the customer orders the job, go back to CFS and re-export the job in the inventory tracking 
mode.  
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Detail of what happens during Level 2 
export/import 

When all items in the CFS job are in QB 
When all items on the CFS job are in QB, the job will be imported into QB and open 
automatically if QB is running. It is recommended that you have QB running during transfers so 
you can immediately convert sold jobs into sales orders or invoices if necessary. If QB is not 
running, the job will be imported but will not open automatically. 

Why would some items not be in QB already? 

 
• QB Premier is limited to 14,500 items and some CFS vendor import modules can 

include tens of thousands of items in one product line. For example Ameristar 
includes 41,000 items. 

• Even though QB Enterprise can contain 100,000 items, most people do not want 
thousands of never sold items in their QB item list. 

• To accommodate for this situation we recommend to initially populating QB with 
only commonly sold items. Uncommonly sold items would get transferred to QB 
only as needed. For example only Ameristar products actually sold would end up 
in the QB item list. There will also be the option to not add uncommon items 
into QB by turning them into write-in entries prior to transfer resulting in the 
use of a catch-all item in QB that can be used over and over again.  

• Letting items populate QB through the export/import process is another way to 
introduce new product offerings into the system. You can put the new items into 
CFS, enter one of each item into the miscellaneous estimator, and export this 
listing to QB. By the time the estimate is created in QB the new products will be 
in the QB item list. Simply delete the newly created QB estimate since you only 
borrowed that process to create it. 

 
Note: When the items are imported to QB they will be on the primary level. You will need to 
make then sub items either manually or by using one of QuickBooks’ mass updating tools.  
 

Assemblies (Not applicable if not planning to track inventory.) 
 
Inventory assemblies in QB are equivalent to Assemblies (a.k.a. Additional Pricing Functions) in 
CFS. There are what is referred to as “permanent assemblies” and “reusable assemblies” in QB 
for purposes of this interface. Even though fabrication charges come into play in CFS, they will 
not transfer into the components of reusable assemblies in QB. Regardless, while the cost will 
be different, the selling price in both CFS and QB can be the same if the user prefers them to be 
(recommended). 
 

Permanent assemblies 

Permanent inventory assembly items are what you would normally think of. They are items 
fabricated by your business with your purchased raw material. They are setup as Assemblies 
(a.k.a. Additional Pricing Functions) in CFS and may or may not currently be setup in QB. 
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Assemblies will not be transferred to QB along with the commonly sold items during the initial 
setup. They would either get transferred as needed when an estimate containing one or more is 
transferred to QB or the user can create a CFS Miscellaneous Estimate containing up to 100 
different assemblies per estimate and transfer the estimate to QB. After “borrowing” the export 
feature to populate assembly items into QB it is recommended you delete the estimate in order 
to avoid confusion later. The interface will automatically build each assembly in QB but that is 
okay because the total value of inventory will stay the same and additional assemblies will only 
be built if needed. 
 
If you change the description or components of an assembly in CFS the interface will update 
the assembly in QB automatically the next time it is transferred to QB. 
 
It is important to verify that all the assemblies have a U flag if you want the interface to track 
the component parts used to build that assembly. A “U” flag stands for Un-assemble and 
instructs the program to track the inventory used to build it. Usually an assembly does contain 
component parts you want tracked. But assemblies can also be setup for pricing purposes only. 
For example you could have a record in CFS for the price per 1000 board feet for a certain kind 
of wood. (Maybe that is how your vendor quotes prices to you.) You could have a board setup as 
an assembly with a component part set to the quantity of the per 1000 board foot record. When 
you update the price in the per 1000 board foot record the board price will update 
automatically. In this case, for inventory purposes you want to track the sale of the board, not 
its component. When assemblies are used this way they are not real assemblies of tangible 
items but it works very nice for minimizing the maintenance of product costs. Another example 
would be if you setup all the fabric recordd to have components of records of the price per 
square foot. You’ll want to track the feet of fabric, not the price per square foot. This will work 
just fine if the record does NOT contain a U flag. 
 
A “U” flag is not needed if an “E” flag is in the assembly record. E stands for Explode and 
instructs the program to break out the components to list in the bill of materials. Therefore, 
these assemblies are no longer assemblies by the time they are on the list of materials in the 
CFS job and do not enter the picture by the time the job is exported to QB. This is also why they 
do not need a U flag as they automatically “un-assemble” into the material list when used. 
 

Reusable (Temporary) Assemblies 

 
When fabricated products like fabricated chainlink gates and posts or PVC or ornamental posts, 
rails, pickets, or complete sections are on a job to be exported, the only way to track the 
inventory involved in the production of these parts is to create an assembly in QB. In order to 
not create a permanent assembly for every single different piece that might ever be fabricated 
as this would soon use up all the item spots available to QB, instead, it will treat these 
fabricated part assemblies as reusable. They will not be meant for permanent individual 
assembly tracking. The assembly will stay intact for a job throughout the life of the sales order. 
After the job has been invoiced then that fabricated assembly item is available to get reused for 
a new fabricated part coming in from CFS. 
 
The names of the reusable assembly items in QB will be the following. 
 
Fabricated Chainlink Scratch Builder gates will be: 
FABRICATED, FABRICATED 1, FABRICATED 2, etc.  
 
Fabricated Chainlink Scratch Builder posts will be: 
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FAB-POST, FAB-POST 1, FAB-POST 2 etc. 
 
PVC and ornamental fabricator module fabricated individual post, rails, and pickets will be: 
FAB-PIECE-P, FAB-PIECE-P 1, FAB-PIECE-P 2, etc. or, 
FAB-PIECE-O, FAB-PIECE-O 1, FAB-PIECE-O 2 
 
PVC, ornamental, and wood fabricator module fabricated whole sections will be: 
SECTION-P, SECTION-P 1, SECTION-P 2, etc. or, 
SECTION-O, SECTION-O 1, SECTION-O 2, etc. or, 
SECTION-W, SECTION-W 1, SECTION-W 2, etc. 
  
For example CFS fabricates chainlink gates and posts. Unless you have the chainlink scratch 
builder setup to use pre-built posts on a job it takes the pipe price/foot item times the feet 
needed for the post and adds a cutting charge. For these fabricated posts the pipe item in QB 
would be for a foot – not a stick – and it would be the feet of pipe that is tracked in QB. This is 
a straight forward easy way to track pipe. (There is a way to track sticks of pipe. However, it 
involves a fairly complicated CFS setup process. Please call if you want to discuss this in more 
detail.) The reusable assembly for this post would be named FAB-POST. Each time a fabricated 
post is transferred in a job to QB, the interface would reuse an item named FAB-POST but 
change the description, the component part, and the cost and selling price. If the FAB-POST 
reusable assembly is on a Sales Order in QB the interface will create a new reusable assembly 
item named FAB-POST 1 for the next incoming post. When the Sales Order that includes the 
item FAB-POST is invoiced, FAB-POST become available for reuse. This same logic is used for all 
the CFS fabricated products. 
 

Adequate inventory required to “Build” Assemblies 

(Not applicable if not planning to track inventory.) 
 
If there are any assemblies, permanent or reusable, in a job, there has to be enough component 
parts on-hand in QB to build the assemblies in order for the transfer to take place. If there is 
not enough, a report will pop up about which inventory items are deficient. After receiving an 
adequate amount of these items in QB you can try the transfer again. If you prefer, you can use 
the APF.exe app to export assemblies from CFS and see all the products for permanent 
assemblies that need to be on hand if that assembly is transferred.  
 
If an item is an assembly in CFS but not an assembly in QB (an undesirable situation) and it is 
on a job being transferred, it will not complete the transfer because the interface will not be 
able to build the assembly. The situation would need to be rectified before the job could be 
transferred. 

Write-in Entries 
CFS allows the user to include an item on an estimate that is not in the Master File (CFS’s item 
list). Items are entered by typing a “W” for (W)rite as the Part Number. CFS recognizes this as a 
special entry and automatically gives it a Part Number starting with the word CUSTOM. These 
entries are handled in QB the same way as the CUSTOM parts described in the previous section 
of this manual. If you have some items (but not all your items) in your Master File that you want 
treated as non-inventory temporary items you can put the Part Number of “CUSTOM” in each of 
those items. You can use a different designation from “CUSTOM” repeated in these items if you 
would like to. Just be sure to have them be non-inventory items. They will be reused each time a 
new estimate comes over with that part name/number. However, in order to minimize how 
many of these special items are in QB it is recommended you use the designator “CUSTOM” for 
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the part name/number of items in CFS you want to be handled by the interface in this special 
way. 
 

Importance of treating estimates different from sold jobs when 
exporting 
 
A QB assembly needs to be "built" in order for its component parts to be deducted from 
inventory, which is normally a manual task within QB. It is not practical to require the user to 
individually build the assembly for each fabricated part in order to keep the inventory tracking 
updated. So instead, when a job is exported from CFS and imported to QB the fabricated 
assembly will get created and built immediately and automatically. The inventory count of the 
components will get decremented and the inventory count of the assemblies will get 
incremented appropriately. The cost of the assembly is the sum of the cost of the components 
so the total value of inventory will stay the same. When the sales order is converted into an 
invoice the count of the non-assembly items and the count of the assembled items will get 
deducted from inventory.  
 
As you can see, you would not want it to be deducting the raw material that went into the 
various scratch builder fabricated parts if the job is not sold. Thus, if the job is not sold but 
you want to export it to QB anyway, maybe to use some QB functionality, the job needs to be 
exported in a non-inventory tracking mode so it will not build assemblies in QB for fabricated 
parts or permanent assemblies. There is a setting on the export window for either mode. When 
it is in the non-inventory tracking mode the interface uses non-inventory reusable items in QB 
named CUSTOM, CUSTOM 1, CUSTOM 2, etc. If the job is later sold, you need to load it in CFS 
and export it again, this time in the inventory tracking mode. 
 
Note: You can set the inventory tracking/non-tracking default mode in the Program 
Configuration of the Cash Register program or on the Accounting tab in Update Master File. 
  
Why do we need to do it this way? CFS is quite sophisticated in its ability to let the user 
fabricate virtually an unlimited variety of products on an as needed basis. There is no way to 
"mock" this ability in QB - QB doesn't have a mechanism for virtually unlimited "what if" 
fabrication scenarios. So basically, you would be "borrowing" the estimate mode in QB for non-
sold jobs in the non-inventory tracking mode.  
 
The trade off benefit of having to send the job twice is, when you send a sold job in the 
inventory tracking mode you get EXACT, AUTOMATIC, and SMOOTH inventory tracking of all 
parts which includes regular parts, components of permanent assemblies, and the components 
of the potentially unlimited number of products that could be fabricated by CFS. 
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Deleting Sales Orders 
 
If a Sales Order does not contain any assemblies it can be deleted as usual. However, if a Sales 
Order contains any assemblies, special considerations could be taken to reverse the “build” if 
necessary. Remember that the component parts are already deducted from inventory. This 
happened when the job was imported from CFS. If the part is already fabricated in the shop and 
you are still going to charge the customer, delete any non-assemblies from the Sales Order if 
you prefer, and convert the remainder into an Invoice. 
 
If you have not actually fabricated the assemblies yet, and are willing to cancel the entire Sales 
Order, you should make an inventory adjustment to reverse the builds either immediately 
before or after you delete the sales order. This is particularly important for the special 
assemblies for items fabricated by CFS as needed for a particular job. See the section in this 
manual on temporary reusable assemblies to identify these assembly items in QB. Reversing the 
build of permanent assemblies is optional as the interface will only build more of them during 
an export if there are not enough on-hand at the time of the export. To reverse a “build” go to 
“Adjust Quantity On Hand” in QB. 
 
The quantity of each of these assemblies should equal the number “On Sales Order” at any 
given time. By reversing the build at the time of deleting a Sales Order you will be keeping these 
amounts correct. If you leave one of these assemblies in stock, but not on a sales order, the 
interface will reuse it by adding to the quantity and averaging the cost in order to keep the total 
value of inventory correct. 
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Interface Maintenance 

Syncing the CFS and QuickBooks item lists 

Introduction 
It is important that no one is running CFS when the syncing of inventory counts or prices is 
taking place between CFS and QuickBooks. The only programs that would normally be open 
during these activities are the main menu and Update Master File on the computer where the 
setup or maintenance is taking place. All other users on a network, if you have a network, 
should close out of CFS completely. A reminder will pop up for the person initiating the setup 
or maintenance program. The syncing of the two programs is done in CFS Update Master File. 
After logging in, bring the Accounting tab to the forefront. It should either look exactly like the 
following window or at least include the menu options that appear here. 
 

 
 
 
 
 
The Control Panel was previously explained. The last option, the Tracking Default is a toggle 
switch so double clicking it switches it on or off. The second option for Setup & Maintenance is 
explained below. 
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Setup & Maintenance options: 

Transfer items from CFS to QB (only relevant to Level 2 installations) 

The easiest way to transfer a few items at a time from CFS to QB is via Miscellaneous Estimator. 
Simply enter one of each item and transfer the job to QB, choosing the appropriate accounts 
while doing so. When transferred this way, the items are at the primary level in the QuickBooks 
item list. If you want these new items to be sub-items, they need to be opened in QuickBooks 
and marked accordingly. 
 
Special consideration regarding assemblies: Regardless of how items get transferred, 
Assembly Items should not be exported into QuickBooks with the initial bulk item population 
of the QB item list. They need to be transferred using Miscellaneous Estimator, or, don’t 
transfer them separately. Just wait and they will get added as needed when jobs including them 
get transferred. 
 
If you need to transfer many items, there are several different ways to go about it. Please 
consult with us about these approaches to see which one is the best way for your particular 
situation and needs. 
 

1. If you are not going to use sub-items in QB, AND, you are not going to use sub-accounts 
for the Inventory, Cost of Goods Sold, and Income accounts, AND, you want almost 
everything in the CFS master file to import into QB, you can import items into QB using 
the Setup & Maintenance option in Update Master File. See the previous image. 

a. Click Export Item List from CFS, have the appropriate items checked,  and then 
click Import. Usually, there are many master file items that do not need to be 
imported so this tool may be only appropriate for people with small master files 
and master files that primarily only contain items the user also wants in the QB 
item list. 

 
2. If you are not going to use sub-items in QB but you do want sub-accounts, the option to 

Select an Existing List of CFS Items may be used.  
a. Use the InterOp utility to export the master file into a spreadsheet program like 

Microsoft Excel. Choose the first InterOp Export to CSV option. 
b. Isolate the items for import into QB into separate spreadsheets, each one 

containing only items that will have identical associated accounts. Save each 
sheet as a csv file. 

c. The csvReFormat program needs to be run on this file to reformat it. To do this, 
put the .csv file into the Apps> Reformat Utility Folder. You can run it and 
browse to the same folder for the .csv file, or, simply click and drag the .csv file 
onto the csvReFormatApp. 
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d. Go to the Control Panel and set the appropriate default accounts. 
e. Go to the Setup & Maintenance program and choose Select an Existing List of CFS 

Items, choose your prepared file, and then Import. 
 

3. If you want to import CFS items into sub-items and sub-accounts in QuickBooks, do not 
use the Setup & Maintenance options.  Instead, go to the Level 2 setup directions in this 
manual. 
 

Adding new items sometime after the initial setup is completed. 

 
4. If a new item needs to be added to CFS and QuickBooks, after the setup phase is 

finished, it is recommended for smoother operation that the user put the item in CFS 
first and then transfer it to QB as items will not have a way to transfer from QB to CFS. 
(Items can be entered manually in both programs but this is not recommended for its 
lack of efficiency and increased room for error.) Go back to step 1 and proceed 
accordingly. 

Transfer inventory count from QB to CFS 

1.  You need to Export Item List from CFS before you can access the Import Item 
Inventory Count window. The primary inventory tracking and valuation will take 
place in QB. The purpose of having an option to update the counts in CFS from QB is 
for if you want to use the CFS per job inventory status alert feature and/or the 
suggested order feature. 
(a)  The status alert feature in CFS can be turned on by going to Update Master File> 

Miscellaneous tab> Modify System Settings> in the Misc group check Show 
Inventory Status During Estimating. 

(b) Setup the parameters for a suggested product order on the Inventory tab in 
Update Master File. 

Sync Prices 
You need to Export Item List from CFS before you can access the Sync Price window. First 
choose the appropriate Export button and then the appropriate Update button. 
 

1. Export Sales Price From CFS 
a. CFS contains more sophisticated pricing options than QB, so it will be the 

primary location for the user to establish the retail prices. It is assumed in this 
discussion that the user wants the retail price to be the same in both programs.  
Recommended procedure: use the tools in CFS, Update Master File, and 
Change Pricing Factors to establish your retail selling prices. Then use the 
interface feature to transfer these retail prices from CFS into QB. 
 

2. Transfer average cost or last purchase price from QB to CFS 
a. This option would be used if you want the cost to be the same in both programs. 

See the following in depth discussion. When you update the costs in CFS you will 
be left in the Update Master File program in CFS. Quit out of Update in order to 
let it recalculate the new retail prices before doing more price syncing in Setup & 
Maintenance. If you now intend to bring that updated CFS retail price into the QB 
selling price make sure you refresh the Export item List from CFS before doing 
so. 
 

3. This process can be quite slow if working over a network. 
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Should you transfer cost in QB to cost in CFS 

 
When deciding if you want to transfer either the average cost or last purchase cost from QB 
into CFS, first consider why you may NOT want to update CFS with cost amounts from QB. 
 
You can have your replacement cost in CFS so that your Retail Price will be calculated on what 
the product will cost the next time you buy it rather than on what you paid for it in the past. 
QuickBooks would contain the cost based on what you paid for the product in the past as 
required for bookkeeping needs. Regardless of the costs being different in each program, both 
programs can have the same selling price. 
 

 
 
In this example the List Price (Cost) is set to the vendor’s list price with a dealer discount of 8%. 
If a dealer already had a supply of this particular product in the yard and this List Price was 
updated to reflect a price hike that occurred AFTER the last shipment – thus making it the 
replacement list price, the new cost will be the replacement cost and an amount higher than the 
cost previously recorded in QB.  
 
As you can see, the Retail Price is calculated based on the Actual Cost plus some optional 
markups plus the margin or markup. This Retail Price can be exported to QuickBooks, which is 
recommended, so the selling price will be the same in both programs. The replacement cost is 
in CFS, the price paid for the product would be in QB, and the selling price would be calculated 
in CFS but exported so it would be the same in QB. 
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Considerations if you do want to transfer costs from QB to CFS. 

 
When you transfer either the Average cost or the Last Purchase cost from QB to CFS, the 
program will update the List Price (Cost) field in CFS. If some items are setup in CFS to have a 
discount applied to the list price it will be critical that you remove the discount as the cost 
number coming from QB will already be net of discounts. As you can see from the detailed 
pricing structure in CFS, if no discount is entered then List and Actual will be the same amount. 
To remove the discount in CFS go to Update Master File> Change Pricing Factors. If you are not 
familiar with how to use this feature please watch the online video tutorial and/or read about it 
in the manual, or call us for support. 
 
You may only have some items in QB out of the entire product line in CFS that has a discount 
applied to it. So you would not want to end up with the situation where only some of the items 
in CFS have a List net of discount and other that are not. To remedy this, you can decrease the 
List Price by the discount amount. To do this go to Update Master File>Change List 
Price>choose the category or group of items to affect>choose Entering a percentage to add to 
the List Price (Cost). Enter a negative percentage, for example -8 to decrease it by 8%.  
 
You can also use InterOp. You could export the Master File to a spreadsheet program, copy and 
paste special the Actual prices into the List Price field and then import back into CFS. 

Purchase Orders 
If the CFS job does not contain any pre-defined assemblies or fabricated products it can be 
transferred to QuickBooks and converted into a PO with no special considerations. However, if 
it does contain items other than in the units you purchase it in, the job needs to be modified 
before it is exported. There are a couple ways to do this. 

Purchase Order for One job 
1. For the simplest of jobs, delete the assemblies and fabricated items and manually add 

the raw material for making those products. 
a. If there is a fabricated chainlink gate or gates involved, print the Fabricated Gate 

Cut Sheet(s) to paper or a pdf for referencing the quantities and Part Numbers of 
the components and add them to the list of materials. Delete the gate(s) from the 
job and add the quantities and parts. 

b. Fabricated posts contain info regarding the raw material for reference for 
editing. 

c. If the job contains a predefined assembly, like a double gate drop rod assembly, 
highlight that line on the estimate and type an “E”. This automatically replaces 
the assembly with all its components instead. When there are no more 
assemblies on the BOM, save it, then export it to QB. Turn it into a PO. 

d. For creating a Sales Order or Invoice for the customer, load the original, non-
edited job in CFS and export it. 
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Creating a PO for multiple jobs 
2. If there are several jobs for which material needs to be ordered: 

a. Merge the jobs together before or after the material for assemblies and 
fabricated products has been accounted for.  

b. When the situation warrants a process can be implemented that eliminates the 
need to manually edit the job(s). This is a semi-automatic way of creating the PO 
in QuickBooks by first using the inventory module in CFS. 

i. Import inventory counts from QB to CFS 

ii. Make sure automatic inventory update is turned on in the CFS Cash 

Register program 

iii. Convert desired estimates into invoices in CFS. Inventory counts will 

automatically be decremented when the invoice is saved upon exit. 

iv. Go to Update Master File Inventory window 

v. Click Sort to deduct  

vi. Generate order 

vii. Manually use this order to create a PO in QB 

viii. Order and receive products 

ix. Go to CFS and transfer invoices to QB 
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Troubleshooting Functionality 

General errors 
1. When exporting a job, get Error: Failed to import. Status Ok 

a. Try the export again. If it fails again, reboot the computer. If it fails again, call 
support. The error message is too general to have a specific solution. Most likely, the 
job file and the program are okay but something in the environment is not working 
ideally. 

 
2. Nothing happens when clicking to Export the job to QB. 

a. The interface may not be installed on this computer.   
 

3. Error: Fail to Import: Estimate Add OR EstimateLineAddList: required list is empty  End 
of EstimateAdd  OK 

a. The application that imports the job into QB cannot find the job file “accxml.xml”. 
This is the file created when exporting from the Interface window. Try to export the 
job again. Reboot the computer. If the problem persists, check the paths in the 
Enterprise.xml file and the Control panel or call for support. 

QuickBooks Customer List on Interface Window 
 

4. The following error pops up when the QuickBooks customer file is refreshed, or, when 
an export to QuickBooks is attempted. 

a.  

 
 

b. There are probably duplicate job names in the QuickBooks customer center. Each 
active job must have a unique name. If one or more jobs with identical names are 
completed, mark the completed jobs Inactive. If there are more than one active jobs 
with the same name, edit as necessary to make sure each name is unique. For 
example, the job start date could be added to the end of the name. 
 

c. A quick way to identify all jobs with identical names is to open the 
C:\CFS\Apps\QB_Interface\customer.csv file in Excel, or another spreadsheet 
program, conditionally format duplicate entries in the name column in color, and 
then sort by color. All the duplicates will be listed in color and together. 

 
d. Refresh the customer list on the Interface window. The module the Interface window 

was accessed from needs to be closed and reopened either before or after the 
customer list is refreshed in order to be able to properly view the new drop down 
list of customers. 
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Issues pertaining to non-inventory CUSTOM items: 
 

5. An imported job with CUSTOM Part Numbers has selling prices different from the prices 
on the job in CFS. 

(a) The CUSTOM parts (CUSTOM, CUSTOM 1, CUSTOM 2, ….~CUSTOM 12) may not 
have been added to the items in QB prior to the job import. This is a setup 
requirement covered earlier in this manual. 
(i) If you have the situation where there is a discount applied to the job, AND 

the CUSTOM items are new to QB at the time of the import, AND you choose 
to import the job as a QB Group, the prices will not reflect the discount 
applied to the job in CFS. 

(ii) To correct the current job, first delete the estimate from QB. Next make sure 
the newly imported CUSTOM items are set to be Non-inventory items and 
then import the same job again. Now that the items are not new to QB the 
prices should be correct. 

(iii) You should also add the rest of the CUSTOM items through about CUSTOM 
12 as non-inventory items so that this situation does not occur again. 

 
6. The description of my “Custom” item on my transaction in QB is different from the item 

on the transaction in CFS. 
(a) Make sure the Custom items are in QB as Non-Inventory Parts and are NOT 

marked as Inactive. 
(b) Make sure a newly created Custom item does NOT have an associate  Unit of 

Measeure. 
(c) Also make sure there is NOT a check mark in the box next to “This item is used 

in assemblies or is purchased for a specific customer:job.” This will cause there 
to be either no description or the description will be whatever happened to be in 
that item in the item list instead of the item description coming from CFS. 

 
7. The CUSTOM letter extension on a job transfer is different from what is set in the item 

in CFS. 
a. This is because the job was saved BEFORE the letter in the item was added and the 

letter is different from the default letter the program automatically uses if there is 
no user defined letter. Re-creating the job from scratch or simply forcing a 
recalculation of the job will solve the problem.  

 
 

Part Number issues: 
8. After a job is transferred to QB, an item(s) on the list of materials has an incorrect Part 

Number. It may be the PN of the item just before it. 
(i) This could happen if the U/M is turned on in QB but the item(s) does not 

have an entry in the Unit (standard) field in CFS. Enter a unit description and 
try the transfer again. 

 
9. QuickBooks will not allow a certain Item name/number to be used. 

(i) You may have an Inactive part with that name/number already. Display your 
inactive items and you can see. If you need that name/number, rename the 
inactive items and then you can use it for the new active item. 
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10. When transferring a job, a message pops up reporting that an item does not have a Part 
Number. To identify the item missing a Part Number, do the following. 

(i) First click View/Edit Estimate in CFS. Make sure you are in the view where the 
second column is displaying the Part Numbers. Scan the numbers in this 
column. If an item does not have a Part Number the program displays the 
record number. If you see an item that looks suspicious, open it in Update 
Master File where you can view the specific Part Number field. If it is empty, 
simply add a Part Number. If that item is already in QuickBooks, make sure 
they have the same ID in both programs. 
 

(ii) The item with the missing Part Number might be a component of an 
assembly and will not display on the BOM. You can analyze the specific file 
the interface was trying to read. 

 
(1)  Go to “My Computer” or “Computer” or Windows Explorer and browse to 

your local QB_Interface folder, probably at C:\CFS\Apps\QB_Interface. 
Right click on the “Export” xml file. (This file name is configured in the 
Enterprise.xml file in the root of the CFS folder and could conceivably 
have a different name but this is the default name.) 

(2) Choose to open it with Notepad. The Part Numbers of items are labeled 
<part> so click Edit and Find <part>. As you click “Find Next”, look for 
any items with <part></part>. Notice how there is nothing between the 
two labels indicating there is no Part Number. Now view the item 
description or Source Number, if there is one, to know which item to add 
a Part Number to. 
 

Maintenance functionality 
11. When doing the maintenance tasks of exporting new selling prices to QB or transferring 

costs or inventory counts to CFS, it takes way too long to load data from either CFS or 
QB. Here is a way to speed this up. 

 
(i) If you are working on a network workstation, this means the data is loading 

across your network and that is probably why it is taking so long. If you have 
the option to do the task while sitting at the server, you could do that and it 
would be much faster. 

(ii) If that is not an option, you can speed things up by doing your work locally. 
You will be copying your CFS data files to your local computer, doing the 
maintenance task, and then putting the Master file back on the server. Make 
sure no one changes anything in Update Master File while you are doing this 
operation because any changes to the Master File by someone else while you 
are in “possession” of the data files will be lost when you put it back. When 
you are done you’ll only be transferring the MASTER.0 file back to the server 
in order to avoid inadvertently influencing the invoice numbering system, the 
Job Scheduling program, etc. 

(iii) To proceed, copy the MASTER.0 and all the files beginning with SAVE from 
CFS on the server into your local CFS folder. Run the Control Panel and 
change the CFS path to the local folder. Now run maintenance and do your 
task. When finished, copy just the MASTER.0 back into the CFS folder on the 
server.  

(iv) Run the Control Panel program again and change the CFS path back to the 
server path. 
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12.  Error 76, Path not found when trying to do the maintenance tasks of transferring costs 
or inventory counts from QB to CFS. 

(i) If the transfers are to take place over a network, the interface launches 
InterOp and Update.exe from the server/host CFS folder. The CFSSetup.dat 
file in the server CFS folder may not have a correct data path in it. You can 
right click it, open it with Notepad, make the correction and save. 

(ii) Or, you can copy the CFSSetup.dat file from the local CFS folder into the 
server CFS folder. 

QuickBooks functions 
13.  View how much is on hand when creating a PO. 

i. It has been reported that QB has a version that lets you view the on hand 
count while creating a PO. Ask QB for more information.  

 
14. When trying to install QuickBooks, get “Error, Third Party components are not 

found”. (This info was applicable in 2011 so may or may not be current.) You can get 
another copy of your program to install. 

b. Go to the website: 
http://support.quickbooks.intuit.com/support/Articles/INF12417 and download 
your product. Save the file when downloading and then run it to install. 
 

15. QuickBooks freezes up when an Advanced Import of items is attempted. 
c. There is a bug in some versions of QuickBooks that causes the program to freeze 

when a map is being created for importing items from an Excel file into the 
QuickBooks items list. To avoid this issue, first click to the left of the first line, 
normally Type, before clicking on the right hand side. 

i.  

1.  
 

ii. Next click to the right of the Type, or whatever is on your first line, in 
order to see the field names of the Excel file. See the image below. 
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iii. Continue with the mapping and the import. If the import detects a 
conflict, it will generate an error log. Save the error log and open it to 
view the messages describing the issue causing the conflict. 

 
 
 


